VERY LARGE TELESCOPE

Reflex ESPRESSO DAS Tutorial

VLT-MAN-ESP-13520-275

Issue 1.3.3
Date Feb 22, 2021

Prepared: Valentina D’Odorico  Feb 22, 2021
Approved: W. Freudling
Released: M. Sterzik
This page was intentionally left blank
Change record

<table>
<thead>
<tr>
<th>Issue/Rev.</th>
<th>Date</th>
<th>Section/Parag. affected</th>
<th>Reason/Initiation/Documents/Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.1.3</td>
<td>20/05/2019</td>
<td>All</td>
<td>Public release update</td>
</tr>
<tr>
<td>1.2.0</td>
<td>26/05/2020</td>
<td>All</td>
<td>Update for pipeline version 1.2.0</td>
</tr>
<tr>
<td>1.3.0</td>
<td>22/02/2021</td>
<td>none</td>
<td>Update for pipeline version 1.3.3</td>
</tr>
</tbody>
</table>
This page was intentionally left blank
Contents

1 Introduction And Scope 9
  1.1 Workflow functionalities ......................................................... 9
    1.1.1 STAR I workflow .......................................................... 9
    1.1.2 STAR II workflow ........................................................ 9
    1.1.3 STAR III workflow ....................................................... 10
    1.1.4 Coadd workflow ......................................................... 10
    1.1.5 QSO I workflow .......................................................... 10
    1.1.6 QSO II workflow ....................................................... 10
    1.1.7 Coadd workflow ......................................................... 11
  1.2 Reference documents ......................................................... 11

2 Software Installation 13
  2.1 Installing Reflex workflows via macports .................................. 13
  2.2 Installing Reflex workflows via rpm/yum/dnf ................................ 13
  2.3 Installing Reflex workflows via install_esoreflex ....................... 14

3 Demo Data 16

4 Quick Start: Reducing the Demo Data 17

5 Reducing your own data 20
  5.1 The esoreflex command ..................................................... 20
  5.2 Launching the workflow .................................................... 20
    5.2.1 Data Organisation And Selection .................................... 23
    5.2.2 DataSetChooser ....................................................... 24
    5.2.3 The ProductExplorer ................................................ 25

6 About The Reflex Canvas 27
  6.1 Saving And Loading Workflows ........................................... 27
  6.2 Buttons ............................................................................. 27
  6.3 Workflow States ............................................................... 27
6.4 Workflow Canvas Parameters .............................................. 28
6.5 Simple Actors ............................................................. 28
6.6 Lazy Mode ................................................................. 29

7 The ESPRESSO DAS Workflows 31

7.1 The ESPRESSO DAS STAR I workflow ................................. 31
   7.1.1 Starting the workflow ............................................. 31
   7.1.2 Frame coaddition ............................................... 32
   7.1.3 Measurement of the equivalent widths ....................... 33
   7.1.4 Determination of the stellar parameters and final products 34

7.2 The ESPRESSO DAS STAR II workflow .............................. 35
   7.2.1 Starting the workflow ........................................... 35
   7.2.2 Frame coaddition ............................................... 36
   7.2.3 Continuum fitting .............................................. 36
   7.2.4 Generation of the synthetic spectrum ....................... 37
   7.2.5 Estimate of the stellar radial velocity .................... 38
   7.2.6 Final products .................................................. 39

7.3 The ESPRESSO DAS STAR III workflow ............................. 40
   7.3.1 Starting the workflow ........................................... 41
   7.3.2 Estimate of the stellar radial velocity .................... 41
   7.3.3 Estimate of the stellar activity index R’HK .................. 42
   7.3.4 Final products .................................................. 42

7.4 The ESPRESSO DAS COADD workflow .............................. 43
   7.4.1 Starting the workflow ........................................... 44
   7.4.2 Frame coaddition ............................................... 44
   7.4.3 Final products .................................................. 45

7.5 The ESPRESSO DAS QSO I workflow ................................. 46
   7.5.1 Starting the workflow ........................................... 46
   7.5.2 Frame coaddition ............................................... 47
   7.5.3 Mask application ............................................... 48
   7.5.4 Absorption line detection ..................................... 49
7.5.5 Fitting of the continuum level ........................................... 50
7.5.6 Absorption line identification, creation and visualization of absorption systems ........ 51
7.5.7 Final products .................................................................... 52
7.6 The ESPRESSO DAS QSO II workflow .................................. 54
  7.6.1 Starting the workflow ......................................................... 54
  7.6.2 Fitting of absorption lines grouped into systems .................. 55
  7.6.3 Refinement of the continuum estimate - NOT ACTIVE ........... 56
  7.6.4 Final products .................................................................. 56

8  Frequently Asked Questions .................................................. 58

9  Known problems .................................................................. 61
1 Introduction And Scope

Reflex is the ESO Recipe Flexible Execution Workbench, an environment to run ESO VLT pipelines which employs a workflow engine to provide a real-time visual representation of a data reduction/analysis cascade, called a workflow, which can be easily understood by most astronomers. The basic philosophy and concepts of Reflex have been discussed in [2]. Please reference this article if you use Reflex in a scientific publication.

Reflex and the data reduction/analysis workflows have been developed by ESO and instrument consortia. If you have any issue, please contact usd-help@eso.org for further support.

This document is a tutorial designed to enable the user to employ the ESPRESSO DAS workflow to analyse his/her data in a user-friendly way, concentrating on high-level issues such as the quality of the obtained observables.

The ESPRESSO DAS workflows accept science data reduced with the ESPRESSO pipeline and organise them into DataSets, where each DataSet contains one science object observation (possibly consisting of several science files) and all the static calibrations required for a successful data analysis. The data organisation process is fully automatic. The DataSets selected by the user for analysis are fed to the workflow which executes the relevant pipeline recipes (or stages) in the correct order. Full control of the various recipe parameters is available within the workflow, and the workflow deals automatically with optional recipe inputs via built-in conditional branches. Additionally, the workflow stores the analysed final data products in a logically organised directory structure employing user-configurable file names.

1.1 Workflow functionalities

In the following, the functionalities of the ESPRESSO DAS workflows are briefly described.

1.1.1 STAR I workflow

This workflow is designed to estimate in a fast way some stellar parameters: effective temperature and metallicity. It accepts multiple ESPRESSO frames of the same star which are corrected for radial velocity and coadded. Absorption lines are identified in the combined spectrum based on a static input table of wavelengths, and their equivalent width is measured. The default linelist for this step in the workflow is optimized for the derivation of the stellar parameters using line ratios, but it can be changed for other purposes in case of need. The comparison of the ratios of equivalent widths with static calibration tables allows the determination of the effective temperature ($T_{\text{eff}}$) and the metallicity ([Fe/H]) of the star. These parameters together with the associated errors and other QC parameters are written in the header of the rebinned spectrum saved as output of the workflow. The calibration tables used by default in the workflow have been validated and proven to determine parameters for FGK dwarf/sub giant stars.

1.1.2 STAR II workflow

This workflow is designed to estimate the radial velocity of a star by comparing its spectrum with a synthetic spectrum. It accepts multiple ESPRESSO frames of the same star and it fits the continuum of each order of each
frame. Then, it generates an interpolated synthetic spectrum corresponding to the input set of stellar (\(T_{\text{eff}}, [\text{Fe/H}]\) and \(\log g\)) and broadening (instrumental, rotation velocity and macroturbulence) parameters. The estimate of the radial velocity is obtained by fitting the cross-correlation function of the synthetic spectrum with the observed one with a Gaussian/Lorentzian function. The resulting radial velocity with the corresponding error and other QC parameters are written in the header of the rebinned, continuum normalised spectrum which is the output of the workflow. The aim of this workflow is to provide radial velocity estimates below \(\text{km s}^{-1}\) precision, which are useful for those stars for which the radial velocity is not known. This first estimate can then be refined by the following workflow.

1.1.3 STAR III workflow

This workflow provides a very accurate estimate of the stellar radial velocity and a determination of the stellar activity index, \(\log(R'\text{HK})\). It accepts an ESPRESSO stellar spectrum which is cross-correlated with a static input mask of the corresponding stellar type. The obtained cross correlation function is fitted with a Gaussian to determine the radial velocity of the star. Also, it computes the Ca II H&K activity index of the star, as \(\log(R'\text{HK})\).

1.1.4 Coadd workflow

This workflow accepts multiple ESPRESSO frames of the same star or QSO. It performs the coaddition of the spectra using the same recipe as in QSO I. It allows an inspection of the spectrum and an evaluation of the signal-to-noise ratio of the combined frames.

1.1.5 QSO I workflow

This workflow is designed to perform several operations on QSO spectra. It accepts multiple ESPRESSO frames of the same QSO which are coadded. Absorption lines are detected and the continuum is fitted after removing them. A preliminary identification of the most common line doublets is carried out together with the creation of a preliminary list of absorption systems (i.e. Groups of 2 or more identified ionic transitions falling at the same redshift). User intervention is required to verify the validity of the identified systems. The output files of the workflow are: the rebinned spectrum with continuum estimate; the full spectrum (where pixels from different frames and different orders are not merged) with continuum estimate; the list of identified lines and the list of those that have not been identified; the list of systems.

1.1.6 QSO II workflow

This workflow is designed to fit with Voigt profiles the absorption lines identified by the previous workflow. Voigt fitting is carried out automatically, however the user can intervene to modify and improve the fit. The workflow will also allow to improve the continuum estimation and the line identification with the results of the fit; this feature is currently not implemented. The output files of the workflow are: the rebinned spectrum with continuum estimate and Voigt fit; the list of Voigt-fitted lines; the list of identified lines and the list of absorption systems.
1.1.7 Coadd workflow

This workflow performs the coaddition of the spectra using the same recipe as in QSO I. It allows an inspection of the spectrum and an evaluation of the signal-to-noise ratio of the combined frames. It accepts multiple ESPRESSO frames of the same star or QSO.

1.2 Reference documents


2 Software Installation

Esoreflex and the workflows can be installed in different ways: via package repositories, via the install_esoreflex script or manually installing the software tar files.

The recommended way is to use the package repositories if your operating system is supported. The macports repositories support macOS 10.11 to 10.14, while the rpm/yum repositories support Fedora 26 to 29, CentOS 7, Scientific Linux 7. For any other operating system it is recommended to use the install_esoreflex script.

The installation from package repository requires sudo privileges, as it install files in the root directory. If you want a local installation, or you do not have sudo privileges, or if you want to manage different installations on different directories, then use the install_esoreflex script. Note that the script installation requires that your system fulfill several software prerequisites, which might also need sudo privileges.

Reflex 2.10 needs java JDK 11 is be installed.

Please note that in case of major or minor (affecting the first two digit numbers) Reflex upgrades, the user should erase the $HOME/KeplerData, $HOME/.kepler directories if present, to prevent possible aborts (i.e. a hard crash) of the esoreflex process.

2.1 Installing Reflex workflows via macports

This method is supported for the macOS operating system. It is assumed that macports (http://www.macports.org) is installed. Please read the full documentation at http://www.eso.org/sci/software/pipelines/installation/macports.html.

2.2 Installing Reflex workflows via rpm/yum/dnf

This method is supported for Fedora 26 to 29, CentOS 7, Scientific Linux 7 operating systems, and requires sudo rights. To install, please follow these steps

1. Configure the ESO repository (This step is only necessary if the ESO repository has not already been previously configured).
   - If you are running Fedora 26 or newer, run the following commands:
     
     ```bash
     sudo dnf install dnf-plugins-core
     ```
   - If you are running CentOS 7, run the following commands:
     
     ```bash
     sudo yum install yum-utils ca-certificates yum-conf-repos
     sudo yum install epel-release
     ```
• If you are running SL 7, run the following commands:

  sudo yum install yum-utils ca-certificates yum-conf-repos
  sudo yum install yum-conf-epel

2. Install the pipelines

• The list of available top level packages for different instruments is given by:

  sudo dnf list esopipe-\*--all # (Fedora 26 or newer)
  sudo yum list esopipe-\*--all # (CentOS 7, SL 7)

• To install an individual pipeline use the following (This example is for X-Shooter. Adjust the package name to the instrument you require.):

  sudo dnf install esopipe-xshoo-all # (Fedora 26 or newer)
  sudo yum install esopipe-xshoo-all # (CentOS 7, SL 7)

• To install all pipelines use:

  sudo dnf install esopipe-\*--all # (Fedora 26 or newer)
  sudo yum install esopipe-\*--all # (CentOS 7, SL 7)

For further information, please read the full documentation at http://www.eso.org/sci/software/pipelines/installation/rpm.html.

2.3 Installing Reflex workflows via install_esoreflex

This method is recommended for operating systems other than what indicated above, or if the user has no sudo rights. Software dependencies are not fulfilled by the installation script, therefore the user has to install all the prerequisites before running the installation script.

The software pre-requisites for Reflex 2.11 may be found at: http://www.eso.org/sci/software/pipelines/reflex_workflows

To install the Reflex 2.11 software and demo data, please follow these instructions:

1. From any directory, download the installation script:


2. Make the installation script executable:

   chmod u+x install_esoreflex

3. Execute the installation script:
and the script will ask you to specify three directories: the download directory `<download_dir>`, the software installation directory `<install_dir>`, and the directory to be used to store the demo data `<data_dir>`. If you do not specify these directories, then the installation script will create them in the current directory with default names.

4. Follow all the script instructions; you will be asked whether to use your Internet connection (recommended: yes), the pipelines and demo-datasets to install (note that the installation will remove all previously installed pipelines that are found in the same installation directory).

5. To start Reflex, issue the command:

   `<install_dir>/bin/esoreflex`

   It may also be desirable to set up an alias command for starting the Reflex software, using the shell command `alias`. Alternatively, the PATH variable can be updated to contain the `<install_dir>/bin` directory.
3 Demo Data

Together with the pipeline you will receive a demo data set, that allows you to run the Reflex ESPRESSO DAS workflows without any changes in parameters. This way you have a data set to verify the installation and to experiment with before you start to work on your own data. The demo data for the ESPRESSO DAS includes:

• Two frames of the star Tau-Ceti observed in SINGLEHR mode, binned 2 × 1, to be used to test the STAR I, STAR II and STAR III workflows;

• One frame of QSO HE0515-4414 (z_{em} = 1.713) observed in MULTIMR mode, binned 4 × 2, to be used with the QSO I and QSO II workflows;

• One frame of QSO HE0515-4414 (z_{em} = 1.713) observed in MULTIMR mode, binned 8 × 4, to be used with the QSO I and QSO II workflows.

Note that you will need a minimum of ∼2.0 GB, ∼0.6 GB and ∼3.8 GB of free disk space for the directories <download_dir>, <install_dir> and <data_dir>, respectively.
4 Quick Start: Reducing the Demo Data

For the user who is keen on starting data analysis without being distracted by detailed documentation, we describe the steps to be performed to analyse the science data provided in the ESPRESSO DAS demo data set supplied with the esoreflex 2.11 release. By following these steps, the user should have enough information to perform an analysis of his/her own data without any further reading:

1. First, type:

   esoreflex -l

   If the esoreflex executable is not in your path, then you have to provide the command with the executable full path <install_dir>/bin/esoreflex -l. For convenience, we will drop the reference to <install_dir>. A list with the available esoreflex workflows will appear, showing the workflow names and their full path.

2. Open the <wkf_name> by typing:

   esoreflex <wkf_name> &

   Alternatively, you can type only the command esoreflex the empty canvas will appear (Figure 4.0.1) and you can select the workflow to open by clicking on File -> Open File. Note that the loaded workflow will appear in a new window. As an example, the espda_starI_wkf workflow is shown in Figure 5.2.1.

3. To aid in the visual tracking of the reduction cascade, it is advisable to use component (or actor) highlighting. Click on Tools -> Animate at Runtime, enter the number of milliseconds representing the animation interval (100 ms is recommended), and click OK.

4. Change directories setup. Under “Setup Directories” in the workflow canvas there are seven parameters that specify important directories (green dots).

   By default, the ROOT_DATA_DIR, which specifies the working directory within which the other directories are organised, is set to your $HOME/reflex_data directory. All the temporary and final products of the reduction will be organized under sub-directories of ROOT_DATA_DIR, therefore make sure this parameter points to a location where there is enough disk space. To change ROOT_DATA_DIR, double click on it and a pop-up window will appear allowing you to modify the directory string, which you may either edit directly, or use the Browse button to select the directory from a file browser. When you have finished, click OK to save your changes.

5. Change the value of RAW_DATA_DIR so that it points to the demo data for that specific workflow.

   For the espda_coadd_wkf, espda_starI_wkf, espda_starII_wkf, and espda_starIII_wkf workflows, set it to $ROOT_DATA_DIR/reflex_input/espda_star

---

Where <wkf_name> is the name of one of the ESPRESSO DAS workflows: espda_qsoI_wkf, espda_qsoII_wkf, espda_starI_wkf, espda_starII_wkf, espda_starIII_wkf and espda_coadd_wkf.
6. Click the button to start the workflow

7. The workflow will highlight the Data Organiser actor which recursively scans the raw data directory (specified by the parameter RAW_DATA_DIR under “Setup Directories” in the workflow canvas) and constructs the DataSets. Note that the raw and static calibration data must be present either in RAW_DATA_DIR or in CALIB_DATA_DIR, otherwise DataSets may be incomplete and cannot be processed. However, if the same reference file was downloaded twice to different places this creates a problem as esoreflex cannot decide which one to use.

8. The Data Set Chooser actor will be highlighted next and will display a “Select Datasets” window (see Figure 5.2.2) that lists the DataSets along with the values of a selection of useful header keywords\(^2\). The first column consists of a set of tick boxes which allow the user to select the DataSets to be processed. By default all complete DataSets which have not yet been reduced will be selected. A full description of the options offered by the Data Set Chooser will be presented in Section 5.2.2.

9. Click the Continue button and watch the progress of the workflow by following the red highlighting of the actors. A window will show which DataSet is currently being processed.

10. Once the analysis of all datadets has finished, a pop-up window called Product Explorer will appear, showing the datasets which have been analysed together with the list of final products. This actor allows the user to inspect the final data products, as well as to search and inspect the input data used to create any of the products of the workflow. Figure 5.2.3 shows the Product Explorer window. A full description of the Product Explorer will be presented in Section 5.2.3.

11. After the workflow has finished, all the products from all the DataSets can be found in a directory under END_PRODUCTS_DIR with the named with the workflow start timestamp. Further subdirectories will be found with the name of each DataSet.

Due to the variety of (interactive) actions carried out by the ESPRESSO DAS workflows, this quick start section is only a reference for the operations which are common to all of them. The detailed description of how to run the ESPRESSO DAS workflows is reported in the next sections.

---
\(^2\)The keywords listed can be changed by right-clicking on the DataOrganiser Actor, selecting Configure Actor, and then changing the list of keywords in the second line of the pop-up window.
Figure 4.0.1: The empty Reflex canvas.
5 Reducing your own data

In this section we describe how to reduce your own data set.

First, we suggest the reader to familiarize with the workflow by reducing the demo dataset first (Section 4), but it is not a requirement.

5.1 The esoreflex command

We list here some options associated to the esoreflex command. We recommend to try them to familiarize with the system. In the following, we assume the esoreflex executable is in your path; if not you have to provide the full path <install_dir>/bin/esoreflex

To see the available options of the esoreflex command type:

```
esoreflex -h
```

The output is the following.

```
-h | -help                         print this help message and exit.
-v | -version                      show installed Reflex version and pipelines and exit.
-l | -list-workflows               list available installed workflows and from ~/KeplerData/workflows.
-n | -non-interactive               enable non-interactive features.
-e | -explore                       run only the Product Explorer in this workflow
-p <workflow> | -list-parameters <workflow> lists the available parameters for the given workflow.
-config <file>                    allows to specify a custom esoreflex.rc configuration file.
-create-config <file>            if <file> is TRUE then a new configuration file is created in ~/.esoreflex/esoreflex.rc. Alternatively a configuration file name can be given to write to. Any existing file is backed up to a file with a `.bak` extension, or `.bakN` where N is an integer.
-debug                            prints the environment and actual Reflex launch command used.
```

5.2 Launching the workflow

We list here the recommended way to reduce your own datasets. Steps 1 and 2 are optional and one can start from step 3.
1. **Type:** `esoreflex -n <parameters> <wkf_name>`³ to launch the workflow non interactively and reduce all the datasets with default parameters.

   `<parameters>` allows you to specify the workflow parameters, such as the location of your raw data and the final destination of the products.

   For example, type (in a single command line):

   ```
   esoreflex -n
   -RAW_DATA_DIR /home/user/my_raw_data
   -ROOT_DATA_DIR /home/user/my_reduction
   -END_PRODUCTS_DIR $ROOT_DATA_DIR/reflex_end_products
   <wkf_name>
   ```

   to reduce the complete datasets that are present in the directory `/home/user/my_raw_data` and that were not reduced before. Final products will be saved in `/home/user/my_reduction/reflex_end_products`, while book keeping, temporary products, and logs will be saved in sub-directories of `/home/user/my_reduction/`. If the reduction of a dataset fails, the reduction continues to the next dataset. It can take some time, depending on the number of datasets present in the input directory. For a full list of workflow parameters type `esoreflex -p <wkf_name>`. Note that this command lists only the parameters, but does not launch the workflow.

   Once the reduction is completed, one can proceed with optimizing the results with the next steps.

2. **Type:**

   ```
   esoreflex -e <wkf_name>
   ```

   to launch the Product Explorer. The Product Explorer allows you to inspect the data products already reduced by the `<wkf_name>` esoreflex workflow. Only products associated with the workflow default bookkeeping database are shown. To visualize products associated to given bookkeeping database, pass the full path via the `BOOKKEEPING_DB` parameter:

   ```
   esoreflex -e BOOKKEEPING_DB <database_path> <wkf_name>
   ```

   to point the product explorer to a given `<database_path>`, e.g., `/home/username/reflex/reflex_bookkeeping/test.db`

   The Product Explorer allows you to inspect the products while the reduction is running. Press the button [Refresh] to update the content of the Product Explorer. This step can be launched in parallel to step 1.

   A full description of the Product Explorer will be given in Section 5.2.3

3. **Type:**

   ```
   esoreflex <wkf_name> &
   ```

   to launch the `<wkf_name>` esoreflex workflow. The `<wkf_name>` workflow window will appear (as an example we show the STAR I workflow window, Fig. 5.2.1). Please configure the set-up directories `ROOT_DATA_DIR`, `RAW_DATA_DIR`, and other workflow parameters as needed. Just double-click on them, edit the content, and press [OK]. Remember to specify the same `<database_path>` as for the Product Explorer, if it has been opened at step #2, to synchronize the two processes.

³Where `<wkf_name>` is the name of one of the ESPRESSO DAS workflows: espda_qsoI_wkf, espda_qsoII_wkf, espda_starI_wkf, espda_starII_wkf, espda_starIII_wkf and espda_coadd_wkf.
4. (Recommended, but not mandatory) On the main esoreflex menu set Tools -> Animate at Runtime to 1 in order to highlight in red active actors during execution.

5. Press the button 🎥 to start the workflow. First, the workflow will highlight and execute the Initialise actor, which among other things will clear any previous reductions if required by the user (see Section 6.4). Secondly, if set, the workflow will open the Product Explorer, allowing the user to inspect previously reduced datasets (see Section 5.2.3 for how to configure this option).
5.2.1 Data Organisation And Selection

The DataOrganiser (DO) is the first crucial component of a Reflex workflow. The DO takes as input RAW_DATA_DIR and CALIB_DATA_DIR and it detects, classifies, and organises the files in these directories and any subdirectories. The output of the DO is a list of “DataSets”. A DataSet is a special Set of Files (SoF). A DataSet contains one or several science (or calibration) files that should be processed together, and all files needed to process these data. This includes any calibration files, and in turn files that are needed to process these calibrations. Note that different DataSets might overlap, i.e. some files might be included in more than one DataSet (e.g., common calibration files).

A DataSet lists three different pieces of information for each of its files, namely 1) the file name (including the path), 2) the file category, and 3) a string that is called the “purpose” of the file. The DO uses the OCA\(^4\) rules to find the files to include in a DataSet, as well as their categories and purposes. The file category identifies different types of files, and it is derived by information in the header of the file itself. A category could for example be RAW_CALIBRATION_1, RAW_CALIBRATION_2 or RAW_SCIENCE, depending on the instrument. The purpose of a file identifies the reason why a file is included in a DataSet. The syntax is action_1/action_2/action_3/.../action_n, where each action_i describes an intended processing step for this file (for example, creation of a MASTER_CALIBRATION_1 or a MASTER_CALIBRATION_2).

The actions are defined in the OCA rules and contain the recipe together with all file categories required to execute it (and predicted products in case of calibration data). For example, a workflow might include two actions action_1 and action_2. The former creates MASTER_CALIBRATION_1 from RAW_CALIBRATION_1, and the later creates a MASTER_CALIBRATION_2 from RAW_CALIBRATION_2. The action_2 action needs RAW_CALIBRATION_2 frames and the MASTER_CALIBRATION_1 as input. In this case, these RAW_CALIBRATION_1 files will have the purpose action_1/action_2. The same DataSet might also include RAW_CALIBRATION_1 with a different purpose; irrespective of their purpose the file category for all these biases will be RAW_CALIBRATION_1.

\(^4\)OCA stands for OrganisationClassificationAssociation and refers to rules, which allow to classify the raw data according to the contents of the header keywords, organise them in appropriate groups for processing, and associate the required calibration data for processing. They can be found in the directory <install_dir>/share/esopipes/<pipeline-version>/reflex/, carrying the extension .oca
The Datasets created via the DataOrganiser will be displayed in the DataSet Chooser. Here the users have the possibility to inspect the various datasets and decide which one to reduce. By default, DataSets that have not been reduced before are highlighted for reduction. Click either [Continue] in order to continue with the workflow reduction, or [Stop] in order to stop the workflow. A full description of the DataSet Chooser is presented in Section 5.2.2.

Once the [Continue] is pressed, the workflow starts to reduce the first selected DataSet. Files are broadcasted according to their purpose to the relevant actors for processing.

The categories and purposes of raw files are set by the DO, whereas the categories and purpose of products generated by recipes are set by the RecipeExecuter. The file categories are used by the FitsRouter to send files to particular processing steps or branches of the workflow (see below). The purpose is used by the SofSplitter and SofAccumulator to generate input SoFs for the RecipeExecuter. The SofSplitter and SofAccumulator accept several SoFs as simultaneous input. The SofAccumulator creates a single output SoF from the inputs, whereas the SofSplitter creates a separate output SoF for each purpose.

5.2.2 DataSetChooser

The DataSetChooser displays the DataSets available in the “Select Data Sets” window, activating vertical and horizontal scroll bars if necessary (Fig. 5.2.2).

Some properties of the DataSets are displayed: the name, the number of files, a flag indicating if it has been successfully reduced (a green OK), if the reduction attempts have failed or were aborted (a red FAILED), or if it is a new dataset (a black "-"). The column "Descriptions" lists user-provided descriptions (see below), other columns indicate the instrument set-up and a link to the night log.

Sometimes you will want to reduce a subset of these DataSets rather than all DataSets, and for this you may individually select (or de-select) DataSets for processing using the tick boxes in the first column, and the buttons [Deselect All] and [Select Complete] at the bottom, or configure the “Filter” field at the bottom left. Available filter options are: "New" (datasets not previously reduced will be selected), "Reduced" (datasets previously reduced will be selected), "All" (all datasets will be selected), and "Failed" (dataset with a failed or aborted reduction will be selected).

You may also highlight a single DataSet in blue by clicking on the relevant line. If you subsequently click on [Inspect Highlighted], then a “Select Frames” window will appear that lists the set of files that make up the highlighted Dataset including the full filename, the file category (derived from the FITS header), and a selection tick box in the right column. The tick boxes allow you to edit the set of files in the DataSet which is useful if it is known that a certain calibration frame is of poor quality (e.g: a poor raw flat-field frame). The list of files in the DataSet may also be saved to disk as an ASCII file by clicking on [Save As] and using the file browser that appears.

By clicking on the line corresponding to a particular file in the “Select Frames” window, the file will be highlighted in blue, and the file FITS header will be displayed in the text box on the right, allowing a quick inspection of useful header keywords. If you then click on [Inspect] the workflow will open the file in the selected FITS viewer application defined by the workflow parameter FITS_VIEWER.

5 keep the mouse pointer on the file name to visualize the full path name.
To exit from the “Select Frames” window, click [Continue].

To add a description of the reduction, press the button associated with the field "Add description to the current execution of the workflow" at the bottom right of the Select Dataset Window; a pop up window will appear. Enter the desired description (e.g. "My first reduction attempt") and then press [OK]. In this way, all the datasets reduced in this execution, will be flagged with the input description. Description flags can be visualized in the SelectFrames window and in the ProductExplorer, and they can be used to identify different reduction strategies.

To exit from the “Select DataSets” window, click either [Continue] in order to continue with the workflow reduction, or [Stop] in order to stop the workflow.

### 5.2.3 The ProductExplorer

The ProductExplorer is an interactive component in the esoreflex workflow whose main purpose is to list the final products with the associated reduction tree for each dataset and for each reduction attempt (see Fig. 5.2.3).

#### Configuring the ProductExplorer

You can configure the ProductExplorer GUI to appear after or before the data reduction. In the latter case you can inspect products as reduction goes on.

1. To display the ProductExplorer GUI at the end of the datareduction:

   - Click on the global parameter “ProductExplorerMode” before starting the data reduction. A configuration window will appear allowing you to set the execution mode of the Product Explorer. Valid options are:
     - "Triggered" (default). This option opens the ProductExplorer GUI when all the selected datasets have been reduced.
     - "Enabled". This option opens the ProductExplorer GUI at the end of the reduction of each individual dataset.
     - “Disable”. This option does not display the ProductExplorer GUI.

   - Press the button to start the workflow.

2. To display the ProductExplorer GUI “before” starting the data reduction:

   - double click on the composite Actor "Inspect previously reduced data". A configuration window will appear. Set to "Yes" the field "Inspect previously reduced data (Yes/No)". Modify the field "Continue reduction after having inspected the previously reduced data? (Continue/Stop/Ask)". "Continue" will continue the workflow and trigger the DataOrganizer. "Stop" will stop the workflow; "Ask" will prompt another window deferring the decision whether continuing or not the reduction after having closed the Product Explorer.

   - Press the button to start the workflow. Now the ProductExplorer GUI will appear before starting the data organization and reduction.
Exploring the data reduction products

The left window of the ProductExplorer GUI shows the executions for all the datasets (see Fig. 5.2.3). Once you click on a dataset, you get the list of reduction attempts. Green and red flags identify successful or unsuccessful reductions. Each reduction is linked to the “Description” tag assigned in the “Select Dataset” window.

1. To identify the desired reduction run via the “Description” tag, proceed as follows:

   - Click on the symbol at the left of the dataset name. The full list of reduction attempts for that dataset will be listed. The column Exec indicates if the reduction was successful (green flag: "OK") or not (red flag: "Failed").
   - Click on the entries in the field "Description" to visualize the description you have entered associated to that dataset on the Select Dataset window when reducing the data.
   - Identify the desired reduction run. All the products are listed in the central window, and they are organized following the data reduction cascade.

You can narrow down the range of datasets to search by configuring the field "Show" at the top-left side of the ProductExplorer (options are: "All", "Successful", "Unsuccessful"), and specifying the time range (Last, all, From-to).

2. To inspect the desired file, proceed as follows:

   - Navigate through the data reduction cascade in the ProductExplorer by clicking on the files.
   - Select the file to be inspected and click with the mouse right-hand button. The available options are:
     - Options available always:
       - Copy full path. It copies the full name of the file onto the clipboard. Shift+Ctrl+v to paste it into a terminal.
       - Inspect Generic. It opens the file with the fits viewer selected in the main workflow canvas.
       - Inspect with. It opens the file with an executable that can be specified (you have to provide the full path to the executable).
     - Options available for files in the TMP_PRODUCTS_DIR directory only:
       - command line. Copy of the environment configuration and recipe call used to generate that file.
       - Xterm. It opens an Xterm at the directory containing the file.
     - Options available for products associated to interactive windows only:
       - Display pipeline results. It opens the interactive windows associated to the recipe call that generated the file. Note that this is for visualization purposes only; the recipe parameters cannot be changed and the recipe cannot be re-run from this window.
6 About The Reflex Canvas

6.1 Saving And Loading Workflows

In the course of your data analysis, it is likely that you will customise the workflow for various data sets, even if this simply consists of editing the `ROOT_DATA_DIR` to a different value for each data set. Whenever you modify a workflow in any way, you have the option of saving the modified version to an XML file using File -> Export As (which will also open a new workflow canvas corresponding to the saved file). The saved workflow may be opened in subsequent Reflex sessions using File -> Open. Saving the workflow in the default Kepler format (.kar) is only advised if you do not plan to use the workflow with another computer.

6.2 Buttons

At the top of the Reflex canvas are a set of buttons which have the following functions:

- - Zoom in.
- - Reset the zoom to 100%.
- - Zoom the workflow to fit the current window size (Recommended).
- - Zoom out.
- - Run (or resume) the workflow.
- - Pause the workflow execution.
- - Stop the workflow execution.

The remainder of the buttons (not shown here) are not relevant to the workflow execution.

6.3 Workflow States

A workflow may only be in one of three states: executing, paused, or stopped. These states are indicated by the yellow highlighting of the , , and buttons, respectively. A workflow is executed by clicking the button. Subsequently the workflow and any running pipeline recipe may be stopped immediately by clicking the button, or the workflow may be paused by clicking the button which will allow the current actor/recipe to finish execution before the workflow is actually paused. After pausing, the workflow may be resumed by clicking the button again.

The ESPRESSO DAS workflow canvas is organised into a number of areas. From top to bottom left you will find general workflow instructions, directory parameters, and global parameters. In the left part of the canvas you will find the workflow actors themselves.
6.4 Workflow Canvas Parameters

The workflow canvas displays a number of parameters that may be set by the user. Under “Setup Directories” the user is only required to set the \texttt{RAW\_DATA\_DIR} to the working directory for the DataSet(s) to be analysed, which, by default, is set to the directory containing the demo data. The \texttt{RAW\_DATA\_DIR} is recursively scanned by the Data Organiser actor for input data. The directory \texttt{CALIB\_DATA\_DIR}, which is by default within the pipeline installation directory, is also scanned by the Data Organiser actor to find any static calibrations that may be missing in your DataSet(s). If required, the user may edit the directories \texttt{BOOKKEEPING\_DIR}, \texttt{LOGS\_DIR}, \texttt{TMP\_PRODUCTS\_DIR}, and \texttt{END\_PRODUCTS\_DIR}, which correspond to the directories where book-keeping files, logs, temporary products and end products are stored, respectively (see the Reflex User Manual for further details; \cite{1}).

There is a mode of the Data Organiser that skips the built-in data organisation and uses instead the data organisation provided by the CalSelector tool. To use this mode, click on Use CalSelector associations in the Data Organiser properties and make sure that the input data directory contains the XML file downloaded with the CalSelector archive request.

Under the “Global Parameters” area of the workflow canvas, the user may set the \texttt{FITS\_VIEWER} parameter to the command used for running his/her favourite application for inspecting FITS files. This is set by default to \texttt{fv}, but other applications, such as \texttt{ds9}, \texttt{skycat} and \texttt{gaia} for example, may be useful for inspecting image data. It is recommended to specify the full path to the visualization application (an alias will not work).

By default the \texttt{EraseDirs} parameter is set to \texttt{false}, which means that no directories are cleaned before executing the workflow, and the recipe actors will work in Lazy Mode (see Section 6.6), reusing the previous pipeline recipe outputs where input files and parameters are the same as for the previous execution, which saves considerable processing time. Sometimes it is desirable to set the \texttt{EraseDirs} parameter to \texttt{true}, which forces the workflow to recursively delete the contents of the directories specified by \texttt{BOOKKEEPING\_DIR}, \texttt{LOGS\_DIR}, and \texttt{TMP\_PRODUCTS\_DIR}. This is useful for keeping disk space usage to a minimum and will force the workflow to fully re-reduce the data each time the workflow is run.

The parameter \texttt{RecipeFailureMode} controls the behaviour in case that a recipe fails. If set to \texttt{Continue}, the workflow will trigger the next recipes as usual, but without the output of the failing recipe, which in most of the cases will lead to further failures of other recipes without the user actually being aware of it. This mode might be useful for unattended processing of large number of datasets. If set to \texttt{Ask}, a pop-up window will ask whether the workflow should stop or continue. This is the default. Alternatively, the \texttt{Stop} mode will stop the workflow execution immediately.

The parameter \texttt{ProductExplorerMode} controls whether the ProductExplorer actor will show its window or not. The possible values are \texttt{Enabled}, \texttt{Disabled} and \texttt{Triggered}. The latter, recommended, means that the ProductExplorer actor will be shown only at the end of the workflow execution.

6.5 Simple Actors

Simple actors have workflow symbols that consist of a single (rather than multiple) green-blue rectangle. They may also have an icon within the rectangle to aid in their identification. The following actors are simple actors:
- The **Data Organiser** actor.

- The **Data Set Chooser** actor (inside a composite actor).

- The **Fits Router** actor

- The **Product Renamer** actor.

- The **Product Explorer** actor (inside a composite actor).

Access to the parameters for a simple actor is achieved by right-clicking on the actor and selecting **Configure Actor**. This will open an “Edit parameters” window. Note that the **Product Renamer** actor is a jython script (Java implementation of the Python interpreter) meant to be customised by the user (by double-clicking on it).

### 6.6 Lazy Mode

By default, all recipe executer actors in a pipeline workflow are “Lazy Mode” enabled. This means that when the workflow attempts to execute such an actor, the actor will check whether the relevant pipeline recipe has already been executed with the same input files and with the same recipe parameters. If this is the case, then the actor will not execute the pipeline recipe, and instead it will simply broadcast the previously generated products to the output port. The purpose of the Lazy Mode is therefore to minimise any reprocessing of data by avoiding data re-reduction where it is not necessary.

One should note that the actor’s Lazy Mode depends on the contents of the directory specified by the parameter **BOOKKEEPING_DIR** and the relevant FITS file checksums. Any modification to the directory contents and/or the file checksums will cause the corresponding actor to run the pipeline recipe again when executed, thereby re-reducing the input data.

The re-reduction of data at each execution may sometimes be desirable. To force a re-reduction of data for any single **RecipeExecuter** actor in the workflow, right-click the actor, select **Configure Actor**, and uncheck the Lazy mode parameter tick-box in the “Edit parameters” window that is displayed. For many workflows the **RecipeExecuter** actors are actually found inside the composite actors in the top level workflow. To access such embedded **RecipeExecuter** actors you will first need to open the sub-workflow by right-clicking on the composite actor and then selecting **Open Actor**.

To force the re-reduction of all data in a workflow (i.e. to disable Lazy mode for the whole workflow), you must uncheck the Lazy mode for every single **RecipeExecuter** actor in the entire workflow. It is also possible to change the name of the bookkeeping directory, instead of modifying any of the Lazy mode parameters. This will also force a re-reduction of the given dataset(s). A new reduction will start (with the lazy mode still enabled),
but the results of previous reduction will not be reused. Alternatively, if there is no need to keep any of the previously reduced data, one can simply set the `EraseDirs` parameter under the “Global Parameters” area of the workflow canvas to `true`. This will then remove all previous results that are stored in the bookkeeping, temporary, and log directories before processing the input data. In effect, starting a new clean data reduction and re-processing every input dataset.
7 The ESPRESSO DAS Workflows

The ESPRESSO DAS workflows are described in details in the following sections.

7.1 The ESPRESSO DAS STAR I workflow

![Figure 7.1.1: Default canvas of the STAR I workflow.](image)

This workflow allows to quickly estimate the stellar temperature \( T_{\text{eff}} \) and metallicity \((\text{[Fe/H]}\)\) from the comparison of observed line equivalent width ratios with tabulated values. The initial canvas is shown in Fig. 7.1.1.

7.1.1 Starting the workflow

Load and start the workflow as described in Section 4. The workflow will highlight the `Select Datasets` actor which recursively scans the raw data directory (specified by the parameter RAW_DATA_DIR under “Directories” in the workflow canvas) and constructs the DataSets. The actor will display a “Select Datasets” window that lists the DataSets along with the values of a selection of useful header keywords. The first column consists of a set of tick boxes, which allow the user to select the DataSets to be processed; by default all DataSets that have not been processed in a previous session are selected. It is possible to analyze all DataSets one after the other (in this case leave the default selection), or choose just one DataSet and then click the `Continue` button. A window will show which DataSet is currently being processed.
Figure 7.1.2: *STAR I: Interactive window of the Coadd Spectrum actor. The RV applied for the wavelength correction is reported on the top of the spectrum plot: verify that the value is the correct one.*

### 7.1.2 Frame coaddition

When the workflow has finished executing the recipe `espda_coadd_spec` in the Coadd Spectrum actor for the first DataSet, an interactive window will appear (Fig. 7.1.2) which shows a plot of the coadded, rebinned, equalized spectrum (in blue). The bottom panel shows the SNR computed pixel-by-pixel for the rebinned spectrum. Using the buttons at the top of this window, one may pan and zoom in on the spectrum in order to inspect absorption/emissions lines and other interesting spectral features.

The recipe input parameters are shown in the upper right part of the panel, with their default values. A short description and the range of values that can be used for the parameter appear if you pass over its name with the pointer. You can change those parameters and re-run the recipe or click on the Continue Wkf button and go on to the next step. In particular, the `equal-flag` parameter activates the renormalization of the flux level of all frames to that of the frame indicated by the `equal-ref` parameter. With `wavel-min` and `wavel-max` it is possible to set the desired wavelength range of the final spectrum, while `vel-step` sets the velocity step of the rebinned spectrum. During the rebinning operation pixels whose flux deviates more than `kappa` \( \sigma \) from the mean in the considered velocity steps are excluded from the final spectrum. This recipe corrects the spectra for the radial velocity shift, if a valid value of radial velocity is present in the input frame `OCS.OBJ.RV` keyword. When the correction is carried out, the applied value appears on the top of the plot with the coadded spectrum. If the radial velocity value does not appear or if the value determined by the DRS is not correct, the user have to change the parameter `rv` to the correct value and re-run the recipe.

**Note:** The coadding operation may take a long time, in particular, when the velocity step is very small and the number of pixel large.
7.1.3 Measurement of the equivalent widths

The output of the previous recipe will be a one dimensional spectrum corrected for the radial velocity. This is a crucial step for the next recipe, `espda_compu_eqwidth`, which needs to identify the stellar absorption lines in their rest frame wavelengths in order to measure the equivalent widths. The recipe will enter a loop on a line by line procedure reading the wavelengths from the input line list table and measuring the equivalent widths of the corresponding lines in the observed spectrum. The output of the recipe will be the list of lines with the computed equivalent widths and respective errors for each line.

The `Compute EW` actor opens an interactive window (Fig. 7.1.3) showing on the top the fitted lines and on the bottom a scatter plot with the measured equivalent widths as a function of wavelength. The user has the possibility to move the sliding cursor below the top plot to select and view all the lines fitted by the recipe. Note, that for some cases, you may see an empty top plot, meaning that the measurement for that particular line was not reported in the output file. This happens when the line is not detected, or when the line is very small with a line strength weaker than the threshold parameter `ew_min` which is 2 mA by default. If there are many lines for which the plot is empty, most likely many of the lines were not identified. Verify also if, in the lower plot, most of the equivalent widths are equal to zero. In this case please check if the previous recipe sucessfully corrected the RV.

The default parameters are the ones recommended and should work well for most of the (low rotation) stars and for relatively good SNR spectra. The user may tweak the input parameters of this recipe for some specific cases. For example, in case of very low SNR spectra the user may consider to increase the value of `det_line_smwidth` allowing for a more robust identification of the real lines with respect to the fake features created by the poor signal. Another useful tweak may be to change the parameter `space` in case of relatively high rotator stars.
allowing to work on a larger local spectral region and improving the local normalization when the line blends are stronger and wider. In case the user wants to tweak the continuum position for the local normalization, she/he can define the parameter `cont_rejt` at will. The closer to 1 it gets, the higher the continuum level will be (suggested for high SNR). Lower values (0.995 – 0.975) will put the continuum at a lower level (suggested for lower SNR). The default value (−1) implies that the optimal value of `cont_rejt` is computed by the recipe on the base of the SNR written in the header of the spectrum by the previous recipe. This SNR is evaluated at 600 nm and takes into account the coaddition of several spectra if used, otherwise it will be based on the SNR reported by the reduction pipeline for the single spectrum. The user can always check the top plot of the interactive window to see if the position of the local continuum is satisfactory, otherwise it can change this parameter and re-run the recipe. The output of this recipe is a fits table having the same format of the fits table for the input lines to be measured, with additional columns which are filled with the results of this recipe. The fits table contains the following columns: line wavelength and error (WAVEL, WAVEL_ERR), line depth and error (PEAK, PEAK_ERR), the equivalent width (EW) and the full width at half maximum of the line (FWHM) with the corresponding errors (EW_ERR, FWHM_ERR). The errors are computed directly from the line fitting procedure.

**Note:** The recommended line list used here is optimized to obtain reliable results in the following step to determine $T_{\text{eff}}$ and [Fe/H] but the user is free to add, remove, or completely change the input lines to be measured.

**Note:** This recipe can take some time to execute. Typically, it takes more time for cooler stars since each line in the spectrum suffers from more line blending which then requires the recipe to fit more Gaussians to the local spectrum for a more accurate fit.

**Note:** The algorithms used in this recipe are the same used in the ARES Code [3]; [5].

### 7.1.4 Determination of the stellar parameters and final products

The product with the measurements of the equivalent widths for the lines is the input to the next actor, Compute Starpar. The implemented recipe is `espda_compu_starpar`, which will make use of static calibrations to estimate the effective temperature and metallicity [Fe/H] of the observed star. Note that this recipe is fully automatic with no parameters to tweak. The results are stored in the header of the combined spectrum `_RSPEC_PRE.fits`. The keywords that store the obtained values are:

- **HIERARCH ESO DAS TEFF**: the effective temperature;
- **HIERARCH ESO DAS TEFF ERROR**: the error on the effective temperature;
- **HIERARCH ESO DAS TEFF NCALIB**: the number of line ratios used to estimate the temperature;
- **HIERARCH ESO DAS TEFF NCALIBIND**: the number of independent line ratios used;
- **HIERARCH ESO DAS FEH**: the metallicity;
- **HIERARCH ESO DAS FEH ERROR**: the error on the metallicity;
- **HIERARCH ESO DAS FEH NCALIB**: the number of Fe I lines used to estimate the metallicity.
Note: If the user adopts in the previous step a line list with too few lines required for the calibrations, the output of this recipe may be not reliable. Also, the static calibrations used here are valid only for FGK dwarf/sub giant stars. This is a limitation of the calibrations.

Note: If the estimated parameters have large errors, this may be due to one or more of the following reasons: i. you are dealing with very low SNR spectra; ii. very few lines were measured for the calibration; iii. the star is outside the calibration parameter space.

Note: These estimation are based on the TMCALC code [4] and the more recent calibrations derived in [6].

7.2 The ESPRESSO DAS STAR II workflow

Figure 7.2.1: Default canvas of the STAR II workflow.

This workflow allows to estimate the stellar radial velocity by the comparison of the observed spectrum with a synthetic one. The initial canvas is shown in Fig. 7.2.1.

7.2.1 Starting the workflow

Load and start the workflow as described in Section 4. The workflow will highlight the Select Datasets actor which recursively scans the raw data directory (specified by the parameter RAW_DATA_DIR under “Directories” in the workflow canvas) and constructs the DataSets. The actor will display a “Select Datasets” window that lists the DataSets along with the values of a selection of useful header keywords. The first column consists of a set of tick boxes, which allow the user to select the DataSets to be processed; by default all DataSets that have not been processed in a previous session are selected.

It is possible to analyse all DataSets one after the other (in this case leave the default selection), or choose just one DataSet and then click the Continue button. A window will show which DataSet is currently being processed.
7.2.2 Frame coaddition

When the workflow has finished executing the recipe `espda_coadd_spec` in the `Coadd Spectrum` actor for the first DataSet, an interactive window will appear which shows a plot of the coadded spectrum, formed by merging in a single table all the data points of the different frames (Fig. 7.2.2). The bottom panel shows the corresponding noise. Using the buttons at the top of this window, one may pan and zoom in on the spectrum in order to inspect interesting spectral features. In the right part of the panel, the recipe input parameters are shown with their default values. By default the rebinned spectrum is not created at this stage. You can change those parameters and re-run the recipe or click on the `Continue Wkf` button and go on to the next step. In particular, the `equal-flag` parameter activates the renormalization of the flux level of all frames to that of the frame indicated by the `equal-ref` parameter. With `wavel-min` and `wavel-max` it is possible to set the desired wavelength range of the final spectrum. This recipe does not correct the spectra for the radial velocity shift while the barycentric correction is carried out by the DRS.

**Note:** The coadding operation may take a long time, in particular, when the velocity step is very small and the number of pixel large.

7.2.3 Continuum fitting

The next actor `Fit Star Cont` implements the recipe `espda_fit_starcont`, which computes the continuum level order by order in the single frames and then creates the rebinned normalized spectrum. At the end of the computation, an interactive window appears (Fig. 7.2.3) showing in the upper panel the single frame spectra (in blue) and the order-by-order continua (in red). The central panel shows the normalized single frame spectra (in green) while the lower panel shows the normalized, rebinned spectrum.
Figure 7.2.3: STAR II: Interactive window of the Fit Star Cont actor. In the top panel the blue points trace the non-merged spectrum while the red points show the continuum fitted to the single orders.

In general, the default parameters are suited to get good continuum fitting, however they can be changed if necessary. The recipe has to be rerun to apply the new parameter values. In particular, the **ord-lrejt** and **ord-hrejt** parameters are multiplicative factors of $\sigma$ to determine the low and high rejection thresholds to select the pixels with flux values to be fitted for the determination of the continuum level. The spectral orders are fitted with polynomials of different order depending on the wavelengths and assigned by the parameters: **ord-ford410** (for $\lambda < 410$ nm); **ord-ford450** (for $410 \leq \lambda < 450$ nm); **ord-ford510** (for $450 \leq \lambda < 510$ nm) and **ord-ford800** (for $510 \leq \lambda < 800$ nm). The parameter **ord-niter** sets the number of iteration to be carried out for the fitting of the continuum.

This recipe creates also the rebinned spectrum. The velocity step for the rebinning can be modified changing the parameter **flux-velstep**. During the rebinning operation pixels whose flux deviates more than **flux-kappa** $\sigma$ from the mean in the considered velocity steps are excluded from the final spectrum.

### 7.2.4 Generation of the synthetic spectrum

The next step of this workflow is the association of a synthetic stellar spectrum to the observed, normalized, merged spectrum, carried out by the recipe **espda_synth_spec** contained in the actor Synth Spec. The interactive window opened by this actor (Fig. 7.2.4) shows: in the upper panel the rebinned spectrum (in blue) with superposed the synthetic spectrum (in red) and in the panel below the residuals of the difference between the two (in green). The two lower panels show the observed rebinned spectrum (in blue) and the synthetic spectrum (in red) with the parameters used to compute it.

This synthetic spectrum is based on the default values of the stellar parameters, to improve the correspondence
between observed and synthetic spectrum it is necessary to change the parameters to those of the chosen star and click on the Re-run Recipe button. The user can also change the stellar parameters before starting the workflow by double-clicking on the Synth Spec actor. The parameters that can be modified to improve the correspondence between synthetic and observed spectrum are: the effective temperature (synth-teff), the surface gravity (synth-logg), the metallicity (synth-feh), the stellar rotational velocity (synth-vrot), the stellar macroturbulent velocity (synth-vmac) and the instrumental broadening of the lines (synth-vins).

### 7.2.5 Estimate of the stellar radial velocity

The last step of this workflow is the computation of the radial velocity of the analyzed star by computing the cross correlation of the observed spectrum with the synthetic one with the recipe espda_rv_synth called by the actor Synth Rv. At the end of the computation, the actor opens an interactive window (Fig. 7.2.5) showing in the upper panel the observed spectrum (in blue) with the wavelength array corrected for the computed RV, with superposed the synthetic spectrum (in red). The central panel shows in green the residual of the subtraction between observed and synthetic spectra. If there are strong residuals due mainly to the different strength of the lines, the result can be improved by modifying the parameter syn-fct which is a multiplicative factor applied to the synthetic spectrum flux.

In the bottom left panel, we plot the computed cross correlation function (CCF in blue) together with the obtained fit with a Lorentzian function. To fit the CCF with a Gaussian function, the parameter ccf-fitg has to be ticked. The bottom right panel shows a plot of the fit of the CCF core. The default recipe behaviour takes the
7.2.5 Final products

The workflow creates in output two files. The file ∗_CCF_SPEC.fits collects the results of the cross-correlation function of the normalized, merged, observed spectrum with the synthetic spectrum, and the fit to the cross-correlation function. This frame contains the following columns:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>XCCF</td>
<td>velocity array of the cross-correlation function</td>
</tr>
<tr>
<td>YCCF</td>
<td>flux array of the cross-correlation function</td>
</tr>
<tr>
<td>YFIT</td>
<td>flux array of fit to the cross-correlation function</td>
</tr>
<tr>
<td>YCORE</td>
<td>flux array of fit to core of the cross-correlation function</td>
</tr>
</tbody>
</table>

The file ∗_RMERG_SPEC.fits is the normalized, merged, observed spectrum with the RV-corrected wavelength and synthetic spectrum for comparison. This frame contains the following columns:
### Name Description

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAVEL</td>
<td>the wavelength array of the normalized, merged observed spectrum</td>
</tr>
<tr>
<td>MASK</td>
<td>mask of spectral pixels used in the cross-correlation of the observed spectrum with the synthetic spectrum</td>
</tr>
<tr>
<td>PIXSIZE</td>
<td>pixel size of the wavelength array</td>
</tr>
<tr>
<td>FLUX</td>
<td>flux array of the normalized, merged observed spectrum</td>
</tr>
<tr>
<td>FLUXERR</td>
<td>flux error array of the normalized, merged observed spectrum</td>
</tr>
<tr>
<td>MSNR</td>
<td>signal to noise ratio per pixel computed as FLUX / FLUXERR</td>
</tr>
<tr>
<td>SYNTO</td>
<td>flux array of the synthetic spectrum interpolated on WAVEL</td>
</tr>
<tr>
<td>SYNTH</td>
<td>flux array of the broadened synthetic spectrum interpolated on WAVEL</td>
</tr>
<tr>
<td>RESIO</td>
<td>residuals (observed spectrum − synthetic spectrum)</td>
</tr>
<tr>
<td>RESIH</td>
<td>residuals (observed spectrum − broadened synthetic spectrum)</td>
</tr>
<tr>
<td>WAVEC</td>
<td>RV-corrected wavelength array of the observed spectrum</td>
</tr>
<tr>
<td>SYNTC</td>
<td>flux array of the broadened synthetic spectrum interpolated on WAVEC</td>
</tr>
<tr>
<td>RESIC</td>
<td>residuals (observed spectrum − broadened synthetic spectrum) interpolated on WAVEC</td>
</tr>
</tbody>
</table>

### 7.3 The ESPRESSO DAS STAR III workflow

![Figure 7.3.1: Default canvas of the STAR III workflow.](image)

This workflow provides a very accurate estimate of the stellar radial velocity and a determination of the stellar activity index, log(R'HK).

The initial canvas for this workflow is shown in Fig. 7.3.1

Note that the recipes in this workflow do not need to be executed in sequence. To this purpose you can choose between two different OCA rules: espda_starIII_RV_wkf.oca performing only the first step of the workflow and espda_starIII_RHK_wkf.oca performing both steps if the S1D frame is given in input.
7.3.1 Starting the workflow

Load and start the workflow as described in Section 4. The workflow will highlight the Select Datasets actor which recursively scans the raw data directory (specified by the parameter `RAW_DATA_DIR` under “Directories” in the workflow canvas) and constructs the DataSets. The actor will display a “Select Datasets” window that lists the DataSets along with the values of a selection of useful header keywords. The first column consists of a set of tick boxes, which allow the user to select the DataSets to be processed; by default all DataSets that have not been processed in a previous session are selected.

It is possible to analyse all DataSets one after the other (in this case leave the default selection), or choose just one DataSet and then click the Continue button. A window will show which DataSet is currently being processed.

7.3.2 Estimate of the stellar radial velocity

![Image of Stellar Radial Velocity Calculation]

Figure 7.3.2: STAR III:Interactive window of the Compute RV actor. It displays the computed Cross Correlation Function (CCF, green points) and its Gaussian fit (blue solid line) as a function of the radial velocity expressed in km/s, indicating relevant information: the adopted spectral mask type, the computed Radial Velocity (RV) value, and the associated error in km/s units, the Barycentric Earth Radial Velocity (BERV), the Barycentric Julian Date (BJD).

The first step of the workflow contains the recipe `espda_compu_radvel` in the Compute rv actor. The recipe takes in input the reduced S2D_BLAZE frame (in the [extracted pixel, order] space) and cross-correlates it with a mask specific for the type of analysed star. At the end of the computation, the actor opens an interactive window showing the cross-correlation function (CCF). The center of the CCF determines the value of the radial velocity. The user may adjust the values of the RV parameters (in particular `rv_center` and `rv_range` to optimise results and computation time). Note that the default value 9999 of the parameter `rv_center` means
that the recipe will use for \texttt{rv\_center} the value of the FITS keyword \texttt{OCS.OBJ.RV} in the input data. The default value of \texttt{rv\_step} corresponds to the average nominal size (in km/s units) of one pixel for the HR setting.

7.3.3 Estimate of the stellar activity index R’HK

![Figure 7.3.3: STAR III:Interactive window of the Compute RHK actor. It displays the plots of the extracted spectrum of the CaII H and K lines.](image)

The second step of the workflow is the actor Compute RHK with the recipe \texttt{espda\_compu\_rhk} which takes in input the reduced S1D spectrum. The spectrum is corrected by the radial velocity computed in step one, or taken from the \texttt{OCS.OBJ.RV} keyword. The actor opens an interactive window showing the fit of the lines from which the indexes are computed.

7.3.4 Final products

The workflow produces two fits files in output. The image \texttt{*_ESPRESSO\_CCF.fits} reporting the Cross Correlation Function for each order with the last one representing the sum of all the orders\texttt{CCFs}. The image contains also the CCF error and quality map. The results of the CCF fit are recorded in the fits header keywords:

- QC CCF RV: computed radial velocity [km s\(^{-1}\)];
- QC CCF RV\_ERROR: error on the radial velocity [km s\(^{-1}\)];
• QC CCF FWHM: FWHM of the CCF [km s\(^{-1}\)];
• QC CCF FWHM_ERROR: error on the FWHM [km s\(^{-1}\)];
• QC CCF CONTRAST: CCF contrast;
• QC CCF CONTRAST_ERROR: error on the CCF contrast;
• QC CCF MASK: CCF mask used;
• QC CCF FLUX_ASYMMETRY: CCF asymmetry [km s\(^{-1}\)];
• QC CCF FLUX_ASYMMETRY_ERROR: error on the CCF asymmetry [km s\(^{-1}\)];
• QC CCF BIS_SPAN: CCF bisector span [km s\(^{-1}\)];
• QC CCF BIS_SPAN_ERROR: error on the CCF bisector span [km s\(^{-1}\)].

The table *_ESPRESSO_S1D_RHK.fits which is the input S1D merged spectrum with updated FITS header keywords recording the results of the stellar indexes calculation:

• QC RHK CAII_BV: B-V colour of the star;
• QC RHK CAII_S_RAW: uncalibrated calcium S-index;
• QC RHK CAII_SMW: calcium S-index calibrated on Mt. Wilson scale;
• QC RHK CAII_SERR: error on the calibrated S-index;
• QC RHK CAII_RHK: R’HK index;
• QC RHK CAII_RHK_ERR: error on the R’HK index;
• QC RHK CAII_PROT: rotation period of the star;
• QC RHK CAII_PROT_ERR: error on the rotation period;
• QC RHK CAII_AGE: age of the star;
• QC RHK CAII_AGE_ERR: error on the age.

7.4 The ESPRESSO DAS COADD workflow

The COADD workflow executes only the coaddition of the spectral frames and can be used both for stellar or QSO spectra. The initial canvas is shown in Fig. 7.4.1.
7.4.1 Starting the workflow

Load and start the workflow as described in Section 4. The workflow starts by highlighting the Select Datasets actor which recursively scans the directory containing the data reduced by the ESPRESSO pipeline (specified by the parameter RAW_DATA_DIR under “Directories” in the workflow canvas) and constructs the DataSets. The actor will display a “Select Datasets” window that lists the DataSets along with the values of a selection of useful header keywords. The first column consists of a set of tick boxes, which allow the user to select the DataSets to be processed; by default all DataSets that have not been processed in a previous session are selected. Choose one DataSet and then click the Continue button. A window will show which DataSet is currently being processed.

Note: The data organizer will present for a single object one dataset with the sky-subtracted spectrum and one for the non-sky-subtracted spectrum. The present reduction pipeline allows to carry out the sky subtraction with the “pixel” or “smoothed” method. The latter is more appropriate for the weak targets because it performs a subtraction of the sky level fitted with a smoothed function, although it does not subtract emission lines. On the other hand, the “pixel” method carries out a subtraction pixel-by-pixel of the sky measured in fibre B to the observed spectrum in fibre A (after a renormalization for the different efficiency of the two fibres) and it introduces a significant noise into the observed spectrum. As a consequence, if you are sure that your target has been reduced with the “smoothed” method it is preferable to use the sky-subtracted spectrum.

7.4.2 Frame coaddition

When the workflow has finished executing the recipe espda_coadd_spec in the Coadd Spectrum actor for the first DataSet, an interactive window will appear (Fig. 7.4.2) which shows a plot of the coadded, rebinned, equalized spectrum (in blue) superimposed to the coadded, rebinned spectrum (in green). The bottom panel
Figure 7.4.2: COADD: Interactive window of the Coadd Spectrum actor.

shows the SNR computed pixel-by-pixel for the rebinned spectrum. Using the buttons at the top of this window, one may pan and zoom in on the spectrum in order to inspect absorption/emissions lines and other interesting spectral features. In the right part of the panel, the recipe input parameters are shown with their default values. You can change those parameters and re-run the recipe or click on the Continue Wkf button and go to the end of the workflow.

Note: The coadding operation may take a long time, in particular, when the velocity step is very small and the number of pixels large.

7.4.3 Final products

The output of this workflow depends on the input. If the input frames are in S1D format (merged spectra) the output will be: one table that simply collects all the data from the input frames, *_RSPEC_ORIG.fits, and one table with the coadded spectrum rebinned to the step set in the recipe and equalized (by default), *_RSPEC_PRE.fits. If the input frames are in S2D format (spectra in the [wavelength,order] space) the output will be: one table that collects all the data from the input frames, *_FSPEC_ORIG.fits, where each flux value has the information of the order and the frame it comes from; one table that collects all the data from the input frames where the fluxes of the different frames are equalized to the value of the flux in the first frame, *_FSPEC_PRE.fits; and finally, one table with the coadded spectrum rebinned to the step set in the recipe and equalized (by default), *_RSPEC_PRE.fits.
There is then a common product which is a table with the rebinned instrumental profile, RPROF.fits.

The columns for the RSPEC tables are:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAVEL</td>
<td>wavelength [nm]</td>
</tr>
<tr>
<td>MASK</td>
<td>flag for masked rows (deprecated)</td>
</tr>
<tr>
<td>PIXSIZE</td>
<td>pixel size [nm]</td>
</tr>
<tr>
<td>FLUX</td>
<td>flux density $[\text{erg cm}^{-2} \text{s}^{-1} \text{nm}^{-1}]$</td>
</tr>
<tr>
<td>FLUXERR</td>
<td>error on FLUXERR $[\text{erg cm}^{-2} \text{s}^{-1} \text{nm}^{-1}]$</td>
</tr>
<tr>
<td>QUALDATA</td>
<td>data quality (0==OK)</td>
</tr>
<tr>
<td>FLUXRMS</td>
<td>RMS of flux density $[\text{erg cm}^{-2} \text{s}^{-1} \text{nm}^{-1}]$</td>
</tr>
</tbody>
</table>

The columns for the FSPEC tables are the same of the RSPEC tables with the following additional columns:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SPECID</td>
<td>ID of the exposure</td>
</tr>
<tr>
<td>ORDID</td>
<td>ID of the order</td>
</tr>
<tr>
<td>EQFACT</td>
<td>equalizazion factor</td>
</tr>
</tbody>
</table>

The column for the RPROF table are:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WAVEL</td>
<td>central wavelength [nm]</td>
</tr>
<tr>
<td>WAVELMIN</td>
<td>minimum wavelength [nm]</td>
</tr>
<tr>
<td>WAVELMAX</td>
<td>maximum wavelength [nm]</td>
</tr>
<tr>
<td>PROFMIN</td>
<td>minimum row in RSPEC to which the profile is applied</td>
</tr>
<tr>
<td>PROFMAX</td>
<td>maximum row in RSPEC to which the profile is applied</td>
</tr>
<tr>
<td>PROFNORM</td>
<td>array with normalized profile</td>
</tr>
</tbody>
</table>

### 7.5 The ESPRESSO DAS QSO I workflow

The QSO I workflow processes QSO spectra by coadding them, detecting the absorption lines and fitting the continuum level. The last operation of the workflow is the tentative identification of the absorption lines and the creation of the absorption systems. The initial canvas is shown in Fig. 7.5.1.

#### 7.5.1 Starting the workflow

Load and start the workflow as described in Section 4. The workflow starts by highlighting the Select Datasets actor which recursively scans the directory containing the data reduced by the ESPRESSO pipeline (specified by the parameter `RAW_DATA_DIR` under “Directories” in the workflow canvas) and constructs the DataSets. The actor will display a “Select Datasets” window that lists the DataSets along with the values of a selection of useful header keywords. The first column consists of a set of tick boxes, which allow the user to
select the DataSets to be processed; by default all DataSets that have not been processed in a previous session are selected. Choose one or more DataSets and then click the **Continue** button. A window will show which DataSet is currently being processed (Fig. 7.5.2).

**Note:** In the QSO I workflow, each DataSet contains spectra from a single object. The data organizer will present for each object one dataset with the sky-subtracted spectrum and one for the non-sky-subtracted spectrum. The present reduction pipeline allows to carry out the sky subtraction with the “pixel” or “smoothed” method. The latter is more appropriate for the weak targets because it performs a subtraction of the sky level fitted with a smoothed function, although it does not subtract emission lines. On the other hand, the “pixel” method carries out a subtraction pixel-by-pixel of the sky measured in fibre B to the observed spectrum in fibre A (after a renormalization for the different efficiency of the two fibres) and it introduces a significant noise into the observed spectrum. As a consequence, if you are sure that your target has been reduced with the “smoothed” method it is preferable to use the sky-subtracted spectrum.

### 7.5.2 Frame coaddition

When the workflow has finished executing the recipe **espda_coadd_spec** in the **Coadd Spectrum** actor for the first DataSet, an interactive window will appear (Fig. 7.5.3) which shows a plot of the coadded, rebinned, equalized spectrum (in blue). The lower panel shows a selection of the same spectrum (highlighted in the upper panel by a light-blue shaded region), for better inspection of the spectral features. The slider at the bottom can be used to change the central wavelength of the selection, while the checkboxes on the lower left corner can be used to toggle the display of the signal-to-noise ratio per pixel (in green; “SNR” checkbox), to overplot the full non-rebinned spectrum (in grey; “full” checkbox), or to overplot the flux error (in red; “error” checkbox). Using the buttons at the top of this window, one may pan and zoom in on the spectrum in order to inspect interesting spectral features. In the right part of the panel, the recipe input parameters are shown with their default values.
You can change those parameters and re-run the recipe or click on the Continue Wkf button and go on to the next DA step. In particular, the equal-flag parameter activates the renormalization of the flux level of all frames to that of the frame indicated by the equal-ref parameter. With wavel-min and wavel-max it is possible to set the desired wavelength range of the final spectrum, while vel-step sets the velocity step of the rebinned spectrum. During the rebinning operation pixels whose flux deviates more than kappa $\sigma$ from the mean in the considered velocity steps are excluded from the final spectrum.

The recipe reads the QSO emission redshift from the reduced frame keyword OCS.OBJ.ZEM. If for some reason that redshift value is not correct, the parameter zem can be updated. In order to apply the new redshift value the recipe has to be rerun.

**Note:** The coadding operation may take a significant time. In particular, when the velocity step is very small and the number of pixels large.

### 7.5.3 Mask application

The Mask Spectrum actor opens an interactive window, which allows you to select regions of the spectrum that should be masked (e.g. not considered in the following steps). In the upper panel you can mask regions in the rebinned spectrum, while in the lower panel it is possible to mask regions of the individual spectra that has been coadded. The slider at the bottom can be used to select the different individual spectra to be displayed in the lower panel. You can zoom on the interesting regions of the spectrum using the buttons at the top of the window and then select the regions to mask by clicking with the mouse central button the two boundaries of each region (Fig. 7.5.4). When all the regions have been selected, click the Re-run Recipe button to see the masked regions, which will appear in light grey in the spectrum. If you need to add more regions, just follow the same procedure and then click the Re-run Recipe button to see the resulting masked spectrum. When

![Figure 7.5.2: QSO I: The Select Datasets panel with the QSOs to be analyzed.](image-url)
7.5.3 Interactive window of the Coadd Spectrum actor. The sliding cursor below the plots allows to visualize small portions of the spectrum in the lower plot.

the mask is complete click on the Continue Wkf button.

7.5.4 Absorption line detection

The next actor, Detect Lines, identifies the position of absorption lines in the studied portion of the spectrum using the recipe espda_create_linelist. When the recipe has been executed, a window appears showing the detected lines. Small regions of the spectrum can be investigated in the lower panel by moving the sliding cursor at the bottom, same as for the Coadd Spectrum recipe. You can add more lines by clicking with the mouse central button at the position of the line you want to add in the lower panel and then click the Re-run Recipe button to see the detected and the added lines (Fig. 7.5.5). When you are satisfied with the result, click on the Continue Wkf button.

Tip: If too many lines are detected (in particular very weak lines or even false detections) it is suggested to slightly modify the parameters vel-step-min and vel-step-max, which regulates the minimum and maximum size of the smoothing window scanning the spectrum for line detection.

Note: At present, there is a limit on the maximum number of lines that can be manually added to the list (around 50), because the parameter add can be at most ~ 1000 characters long. This will be fixed in a later release.
7.5.4 QSO I: Interactive window of the Mask Spectrum actor after some regions have been selected for masking by clicking on the top panel (vertical red lines). The parameter mask-limit is automatically updated.

7.5.5 Fitting of the continuum level

The next actor, Fit Continuum, runs the recipe espda_fit_qsocont, which splits the quasar spectrum in two regions blueward and redward of the Lyman-α emission. An interactive window will appear (Fig. 7.5.6) showing in the upper panel the spectrum (in blue) with the estimated continuum (in green). A portion of the spectrum is shown in the lower panel, same as for the Coadd Spectrum interactive window; the selected spectral region also shows the position of the nodes used for the C-spline fitting of the continuum (red dots). The checkboxes on the lower left corner can be used to toggle the normalization of the spectrum (“norm.” checkbox), to overplot the flux error (in red; “error” checkbox), or to overplot the model used to fit to the lines and the relative residuals (in light blue; “fit./resid.” checkbox). Small oscillations due to badly fitted strong lines in the red part of the spectrum can be adjusted by increasing slightly the parameter vel-sampl-red, which determines the interval between the nodes of the spline fitting function, and re-run the recipe. Also the parameter vel-sampl-blue can be slightly increased if there are too many fluctuations in the continuum fit of the Lyman-α forest. The continuum can be also adjusted “by hand” by clicking on the lower panel with the mouse central button. In this way, it is possible either to move existing nodes to a different flux level (if the click is within 0.2 nm from an existing node) or to add new nodes at the desired wavelength-flux position. When you are happy with the result, you can move to the next step by clicking on the Continue Wkf button.
Figure 7.5.5: **QSO I: Interactive window of the Detect Lines actor.** It is possible to add new lines by clicking on the lower plot at the position of the line with the mouse central botton and re-run the recipe.

**Note:** This step can take some minutes in particular when the whole spectral range is fitted at the same time. There are still some problems in the fitting of the strong telluric band at 760 nm. If the fitting takes too long try to process smaller regions of the spectrum changing the considered range in the coadd recipe or reduce the number of iteration, **max-iter**, to a minimum of 5.

### 7.5.6 Absorption line identification, creation and visualization of absorption systems

The recipe `espda_iden_syst` included in the actor **Identify Systems** assign a tentative identification to the absorption lines detected by the recipe `espda_create_linelist` by comparing the observed wavelength ratios with the ratios of the most common ionic doublets observed in quasar spectra: N V 123.4, 123.8 nm, Si IV 139.3 140.2 nm, C IV 154.8, 155.0 nm, Fe II 234.4, 238.2, 258.6, 260.0 nm, Mg II 279.6 280.3 nm, Ca II 393.4 396.9 nm. Then, it groups the identified lines into systems, i.e. group of lines with 2 or more transitions (the minimum number of lines in a system is set by the parameter **grp-num**) falling at the same redshift. The minimum redshift difference between two candidate components of a doublet for the identification to be accepted is set by the parameter **mult-dz**. The identified doublets/multiplets can be grouped into single systems if their redshifts differ in velocity less than the value of the **syst-dv** parameter. Finally, absorption lines of the same ionic species are assigned to different redshift systems if they are separated in velocity by more than the value assumed by the parameter **add-dv**.

At the end of the identification process the actor opens three interactive windows: the main window with the
Figure 7.5.6: *QSO I*: Interactive window of the Fit Continuum actor. The red dots visible in the lower plot are the knots of the spline fit.

plots and the parameters, one window (called Systems) with the list of the identified systems named with letters, and one window (called Transitions) with all the transitions that could belong to the system and fall in the considered spectral range (Fig. 7.5.7). The plot window shows in the upper panel the normalized spectrum and the positions of the identified lines (grey crosses). When a system is selected in the Systems window, the lines of the systems are highlighted in green in the upper panel and the transitions belonging to the system are plotted in the lower panel in velocity space. The checkboxes on the lower left corner can be used to overplot the flux error (in red; “error” checkbox), or to overplot the model used to fit to the lines and the relative residuals (in light blue; “fit./resid.” checkbox). The user has to look at all the systems and untick those which are not real (there can be many fake systems). In order to judge if the systems are real, after this operation, re-run the recipe in order to transfer to the next step only the systems that are real. The Transitions window can be used to display the velocity plots of additional transitions that could belong to the same system.

Note: It is currently not possible to add lines on the transition plots like it is done on the window of Detect Lines; this feature will be available in a later release.

7.5.7 Final products

This workflow produces the same fit tables described for the COADD workflow. In addition, the most relevant products of this workflow are the following. The table with all the non merged spectra with a column with the computed continuum level, *_FSPEC_CONT.fits* and the same for the merged rebinned spectrum,
Figure 7.5.7: *QSO I: Interactive windows of the Identify System actor, with one complex system highlighted and plotted.*

*_*RSPEC_CONT.fits. These two tables have the same columns as the corresponding *_*FSPEC/RSPEC_PRE tables with the additional columns:

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FIT</td>
<td>fitted flux density of the absorption lines [erg cm$^{-2}$ s$^{-1}$ nm$^{-1}$]</td>
</tr>
<tr>
<td>CONT</td>
<td>fitted flux density of the emission continuum [erg cm$^{-2}$ s$^{-1}$]</td>
</tr>
<tr>
<td>NORM</td>
<td>flux density normalized to the emission continuum (FLUX/CONT)</td>
</tr>
<tr>
<td>NORMERR</td>
<td>error on normalized flux density (FLUXERR/CONT)</td>
</tr>
</tbody>
</table>

where the column FIT contains the spectrum with the fitted lines. The fit is very rough, with the only aim of subtracting the lines from the spectrum to determine the continuum level.

Then, tables are created reporting the information on the detected lines: a table with the list of identified lines, *_*FLINE_IDEN.fits; a table with the non-identified lines, *_*FLINE_REJ.fits and a number of tables equal to the number of identified absorption systems, *_*SLINE_IDEN_i.fits. The columns in those tables are the following, where the columns with Voigt parameters contain only guess values because lines will be fitted in the QSO II workflow.
7.6 The ESPRESSO DAS QSO II workflow

The QSO II workflow starts from the system identified by the QSO I workflow and fit them with Voigt profiles. The canvas is shown in Fig. 7.6.1.

7.6.1 Starting the workflow

Load and start the workflow as described in Section 4. The workflow starts by highlighting the Select Datasets actor which recursively scans the directory where the products of workflow QSO I have been saved.
Figure 7.6.1: Default canvas of the QSO II workflow.

(specified by the parameter `RAW_DATA_DIR` under “Directories” in the workflow canvas) and constructs the DataSets. The actor will display a “Select Datasets” window that lists the absorption systems identified by the QSO I workflow along with the values of a selection of useful header keywords. The first column consists of a set of tick boxes, which allow the user to select the DataSets (i.e., systems) to be processed; by default all DataSets that have not been processed in a previous session are selected. Choose one Dataset and then click the Continue button. A window will show which Dataset is currently being processed (Fig. 7.5.2).

### 7.6.2 Fitting of absorption lines grouped into systems

The first step of the QSO II workflow is the actor **Fit Lines**, containing the recipe `espda_fit_line`. This actor allows you to fit the lines detected in QSO I and grouped into absorption systems in step 7.5.6. By default the recipe fits the lines adding automatically more components in order to reach a minimum $\chi^2$ value. When the first fit is ready the actor opens three windows: the main window with the plots and the recipe parameters, one (called **Transitions**) with all the transitions that could belong to the system and fall in the considered spectral range, and one window (called **Lines**) with the parameters of the fitted lines (Fig. 7.6.3). The plot window shows in the upper panel the normalized spectrum and the positions of the fitted lines (green crosses). The lower panels display the fitted lines in velocity space. The checkboxes on the lower left corner can be used to overplot the flux error (in red; “error” checkbox), or to overplot the model used to fit to the lines and the relative residuals (in light blue; “fit./resid.” checkbox). The **Transitions** window can be used to display the velocity plots of additional transitions to verify if they are detected. The user can edit the cells of the table in the **Lines** window to change the guess values of the Voigt parameters used in the fit and their constraints. The boxes at the bottom of the window can be used to edit multiple cells at once. After selecting one or more rows in the table, the user can type a suitable value in the boxes below the columns “Redshift”, “Col. d.” (column density), “Therm. br.” (thermal broadening), or “Turb. br.” (turbulent broadening), and click any button on the right of the box: the value will be propagated to all selected rows. The button “V” defines a value that is left
free to vary during the fitting procedure; the button “F” defines a fixed value; the button “C” defines a linked value, i.e. a value that is set to be the same for all rows with the same expression in column “constr.”. Clicking on the “C” buttons also set the proper values of “constr.” between the linked rows, so the user does not need to edit them by hand. The leftmost box should be filled with a suitable name for a doublet (e.g. “CIV”, “SiIV”, etc.). If the users selects two rows and clicks on the buttons on the right of this box, the rows are considered as members of the chosen doublet, and all their Voigt parameters are set to matching values. If the “C” button is clicked, the values of “constr.” are also set. The user can also click on the plots to add further components to the fitted systems. When new components are added, new rows appear in the Lines table, with default Voigt parameters. All modifications to the Lines table come into effect only when the Re-run Recipe button. If the fit is satisfactory, click Continue to proceed in the workflow.

7.6.3 Refinement of the continuum estimate - NOT ACTIVE

The model used to fit the lines at the previous step can be used to refine the estimation of the continuum. This is done by the recipe espda_fit_qsocont in actor Fit Continuum, same as in the QSO I workflow, but with the additional information from Fit Lines. Note: At present the recipe espda_fit_qsocont is not able to process output from espda_fit_line, and the actor Fit Continuum is disabled in this workflow. It will be enabled in a later release.

7.6.4 Final products

This workflow accepts in input the products of the QSO I workflow and produces in output 3 tables. The tables are: *_FSPEC_VOIGT.fits and *_RSPEC_VOIGT.fits, which are the same as *_FSPEC_CONT.fits and
Figure 7.6.3: QSO II: Interactive windows of the **Fit Lines** actor, with components added to improve the $\chi^2$.

`*_RSPEC_CONT.fits` from workflow QSO I but with the column FIT that reports the fitted spectrum with more refined fits of the lines. Then, table `*_SLINE_VOIGT.fits` is produced that reports the list of Voigt-fitted lines with the same columns as table `*_FLINE_IDEN.fits` in workflow QSO I but with the Voigt parameters obtained from the fit.
8 Frequently Asked Questions

• The error window fills the whole screen - how can I get to the Continue/Stop buttons?

Press the Alt key together with your left mouse button to move the window upwards and to the left. At the bottom the Continue/Stop buttons will be visible. This bug is known but could not yet be fixed.

• I tried to Open (or Configure) an Actor while the workflow is running and now it does not react any more. What should I do?

This is a limitation of the underlying Kepler engine. The only way out is to kill the workflow externally. If you want to change anything while a workflow is running you first need to pause it.

• After a successful reduction of a data set, I changed this data set in some way (e.g. modified or removed some files, or changed the rules of the Data Organizer). When I restart Reflex, the Data Set Chooser correctly displays my new data set, but marks it as “reduced ok”, even though it was never reduced before. What does this mean?

The labels in the column “Reduced” of the Data Set Chooser mark each dataset with “OK”, “Failed” or “-”. These labels indicate whether a data set has previously successfully been reduced at least once, all previous reductions failed, or a reduction has never been tried respectively. Data sets are identified by their name, which is derived from the first science file within the data set. As long as the data set name is preserved (i.e. the first science file in a data set has not changed), the Data Organizer will consider it to be the same data set. The Data Organizer recognizes any previous reductions of data sets it considers to be the same as the current one, and labels the current data set with “OK” if any of them was successful, even if the previously reduced data set differs from the current one.

Note that the Product Explorer will list all the previous reductions of a particular data set only at the end of the reduction. This list might include successful and/or unsuccessful reduction runs with different parameters, or in your case with different input files. The important fact is that these are all reductions of data sets with the same first raw science file. By browsing through all reductions of a particular raw science file, the users can choose the one they want to use.

• Where are my intermediate pipeline products? Intermediate pipeline products are stored in the directory <TMP_PRODUCTS_DIR> (defined on the workflow canvas, under Setup Directories) and organised further in directories by pipeline recipe.

• Can I use different sets of bias frames to calibrate my flat frames and science data? Yes. In fact this is what is currently implemented in the workflow(s). Each file in a DataSet has a purpose attached to it ([1]). It is this purpose that is used by the workflow to send the correct set of bias frames to the recipes for flat frame combination and science frame reduction, which may or may not be the same set of bias frames in each case.

• Can I run Reflex from the command line? Yes, use the command:

```
esoreflex -n <workflow_path>/<workflow>.xml
```

The -n option will set all the different options for Kepler and the workflows to avoid opening any GUI elements (including pipeline interactive windows).

It is possible to specify workflow variables (those that appear in the workflow canvas) in the command line. For instance, the raw data directory can be set with this command:
esoreflex -n -RAW_DATA_DIR <raw_data_path> \
<workflow_path>/<workflow>.xml

You can see all the command line options with the command esoreflex -h.

Note that this mode is not fully supported, and the user should be aware that the path to the workflow must be absolute and even if no GUI elements are shown, it still requires a connection to the window manager.

• **How can I add new actors to an existing workflow?** You can drag and drop the actors in the menu on the left of the Reflex canvas. Under Eso-reflex -> Workflow you may find all the actors relevant for pipeline workflows, with the exception of the recipe executer. This actor must be manually instantiated using Tools -> Instantiate Component. Fill in the “Class name” field with org.eso.RecipeExecuter and in the pop-up window choose the required recipe from the pull-down menu. To connect the ports of the actor, click on the source port, holding down the left mouse button, and release the mouse button over the destination port. Please consult the Reflex User Manual ([1]) for more information.

• **How can I broadcast a result to different subsequent actors?** If the output port is a multi-port (filled in white), then you may have several relations from the port. However, if the port is a single port (filled in black), then you may use the black diamond from the toolbar. Make a relation from the output port to the diamond. Then make relations from the input ports to the diamond. Please note that you cannot click to start a relation from the diamond itself. Please consult the Reflex User Manual ([1]) for more information.

• **How can I manually run the recipes executed by Reflex?** If a user wants to re-run a recipe on the command line he/she has to go to the appropriate reflex_book_keeping directory, which is generally reflex_book_keeping/<workflow>/<recipe_name>_<number> There, subdirectories exist with the time stamp of the recipe execution (e.g. 2013-01-25T12:33:53.926/). If the user wants to re-execute the most recent processing he/she should go to the latest directory and then execute the script cmdline.sh. Alternatively, to use a customized esorex command the user can execute

```
ESOREX_CONFIG="INSTALL_DIR/etc/esorex.rc"
PATH_TO/esorex --recipe-config=<recipe>.rc <recipe> data.sof
```

where INSTALL_DIR is the directory where Reflex and the pipelines were installed.

If a user wants to re-execute on the command line a recipe that used a specific raw frame, the way to find the proper data.sof in the bookkeeping directory is via `grep <raw_file> */data.sof` Afterwards the procedure is the same as before.

If a recipe is re-executed with the command explained above, the products will appear in the directory from which the recipe is called, and not in the reflex_tmp_products or reflex_end_products directory, and they will not be renamed. This does not happen if you use the cmdline.sh script.

• **Can I reuse the bookkeeping directory created by previous versions of the pipeline?**

In general no. In principle, it could be reused if no major changes were made to the pipeline. However there are situations in which a previously created bookkeeping directory will cause problems due to pipeline versions incompatibility. This is especially true if the parameters of the pipeline recipes have changed. In that case, please remove the bookkeeping directory completely.
• **How to insert negative values into a textbox?**
  Due to a bug in wxPython, the GUI might appear to freeze when attempting to enter a negative number in a parameter’s value textbox. This can be worked around by navigating away to a different control in the GUI with a mouse click, and then navigating back to the original textbox. Once focus is back on the original textbox the contents should be selected and it should be possible to replace it with a valid value, by typing it in and pressing the enter key.

• **I’ve updated my Reflex installation and when I run esoreflex the process aborts. How can I fix this problem?**
  As indicated in Section 2, in case of major or minor (affecting the first two digit numbers) Reflex upgrades, the user should erase the `$HOME/KeplerData`, `$HOME/.kepler` directories if present, to prevent possible aborts (i.e. a hard crash) of the esoreflex process.

• **How can include my analysis scripts and algorithms into the workflow?**
  EsoReflex is capable of executing any user-provided script, if properly interfaced. The most convenient way to do it is through the Python actor. Please consult the tutorial on how to insert Python scripts into a workflow available here: [www.eso.org/sci/data-processing/Python_and_esoreflex.pdf](http://www.eso.org/sci/data-processing/Python_and_esoreflex.pdf)
9 Known problems

We suggest the user to execute the DAS recipes using default parameters and all the reference calibrations indicated in this manual. The following is a list of currently-known issues with ESPRESSO DAS recipes, and workarounds, if available:

- **WARNING:** The recipe espda_coadd_spectrum can take from a few to several minutes to create the rebinned spectrum, depending on the number of input frames and on the size of the adopted rebinning step.

- The recipe espda_coadd_spectrum implements a new algorithm for kappa-sigma clipping, which should reduce the issues of small steps observed in line profiles, especially at large signal-to-noise ratio (SNR). The problem may occasionally resurface. If the clipping is skipped, the problem disappears, but in this case the order merging is not effective when the SNR is low. In this case, we suggest the following workaround: for high-SNR spectra, the user must choose a high value of kappa (> 5) in espda_coadd_spec to minimize the effect of kappa-sigma clipping, while for low-SNR spectra the user must keep the default value (kappa = 3) to obtain a proper order merging.

- In the STAR III workflow the recipe espda_compu_radvel does not compute the correct radial velocity with the default parameters if the minimum of the CCF does not fall in the range \( \text{rv-center} \pm \text{rv-window} \). If, in the plot created by the recipe, you don’t see the minimum, increase the value of \( \text{rv-window} \) to e.g. 100 km s\(^{-1}\) and run the recipe again. Then modify the value of \( \text{rv-center} \) to the approximate center of the observed CCF and decrease again the size of \( \text{rv-window} \). Run again the recipe to have a more precise determination of the radial velocity.

- In the QSO I and II workflows the continuum fitting recipe (espda_fit_qsocont) can take a long time. To avoid this long processing time it is possible to select smaller regions of the spectrum at the coaddition step (espda_coadd_spec).

- In the QSO II workflow the line fitting recipe (espda_fit_line) sometimes fail to fit complex systems with many components. The issue will be fixed in a later release.

- In the QSO II workflow the continuum fitting recipe (espda_fit_qsocont) and the system identification recipe (espda_iden_system) are currently unable to handle input from the line fitting recipe (espda_fit_line), and are therefore disabled.